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This product is intended for in vitro experimental research use only 

Note: The following suggestions and data are based on information we believe to be reliable. They are offered in good faith, but without guarantee, as 
conditions and methods of use of our products are beyond our control. We recommend that the prospective user determine the suitability of our 
materials and suggestions before adopting them on a commercial scale. Suggestions for use of our products or the inclusion of descriptive material 
from patents and the citation of specific patents in this publication should not be understood as recommending the use of our products in violation of 
any patent or as permission to license to use any patents of ProZyme, Inc. 
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SECTION 1: SAFETY INFORMATION   
The Gly-Q system is intended to be installed and operated by the end user.  To operate the system safely 
please review the following information.  

 
                  Warning: 
 

 
The Gly-Q system is based on capillary gel electrophoresis 
separation driven by high voltage. Do not remove covers. Do 
not perform any maintenance of the electrical components.  

 
                  Warning: 
 

 
This instrument must be connected to an appropriate power 
source.  

 
                  Warning: 
 

 
Follow local biohazard material handling regulations when 
working with human or animal samples.  

 
                  Caution: 
 

 
The instrument autosampler rotates and moves during 
operation. Keep the instrument door closed while running to 
avoid potential pinching hazard. 
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SECTION 2: INTRODUCTION  
 

2.1 The Gly-Q System 
The Gly-Q System is designed as a complete system for rapid analysis of oligosaccharides such as glycans. 
The system is comprised of capillary gel electrophoresis core integrated with a high sensitivity fluorescence 
detector and 96-well autosampler, replaceable capillary gel cartridge, gel recharging pump, Gly-Q Manager 
software and InstantQ assay kits and standards.     

 

2.2 Description of System Components 
The Gly-Q System components are listed below and described in more details in the sections that follow:   

 

 

 

 

 

 

 

 

  

 

 

 

 

 Gly-Q Instrument 

 Gel Recharging Air Pump  

 Replaceable Capillary Gel Cartridge 

 Assay Kit 

 Standards and Controls 

 Gly-Q Manager Software  

 Cartridge Priming Station 

 Gly-X Manifold Spacer 

 

 

  

 

 

 
 

 

  

  

 

 

    
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2.2.1 Gly-Q Instrument 
 

The Gly-Q Instrument is a compact unit comprised of a capillary gel electrophoresis core integrated with a 
high sensitivity fluorescence detector and 96-well autosampler. When used as part of a complete system, 
the instrument facilitates rapid separation, identification and relative quantitation of labeled 
oligosaccharides.   

 

 

 

 

 

 

 

 

 

 

 

 

 

Feature Description 
Instrument status 
LED 

LED light serves as an indicator of the instrument status. The light 
blinks when high voltage is applied to the capillary. 

96-well plate 
autosampler 

The autosampler holds a 96-well microplate, system reagent vials and 
reagent trays. The autosampler moves and rotates during operation. 
The autosampler interior is protected by a hinged plastic door.  

Power button The main power button turns the instrument On and Off.  
Air pressure 
gauge 

Air pressure gauge displays inlet air pressure. 

Air inlet port 1/8 inch tube connector used for connecting instrument to gel 
recharging air pump.  

USB port Computer port.  
Power inlet Power supply port.  
Instrument label Instrument serial number & CE marking 

 

  

Cartridge 
compartment door  

Instrument status 
LED 

96-well plate 
autosampler 

Power button 

Air pressure gauge 

 
Air inlet port 

USB port  

Power inlet  

Instrument label 

Front Back 
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2.2.2 Gel Recharging Air Pump 
 
The gel recharging air pump connects to the instrument and provides air pressure for automated recharging 
of the capillary with gel between sample injections.  

 

 

 

 

 

Feature Description 
Air pressure regulator Regulator for adjusting air pump output pressure. 
Air pressure gauge Air pressure gauge displays air pump output. 
Air tubing 1/8-inch tubing connects the pump to the instrument (not shown).   
Power switch 
Condensation trap 

Power switch turns the pump On and Off.  
Condensation trap collects condensate from air pump. This should be cleared 
weekly as routine maintenance.  

 
 

 

2.2.4 Cartridge Priming Station  
 
The cartridge priming station is designed to prepare the cartridge for the first time use before installing it 
into Gly-Q Instrument. The priming station can also be used to help troubleshoot cartridge clogging. 

  

Air pressure regulator  
 
Air pressure gauge 
 
Condensation trap 

Power switch 
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2.2.3 Replaceable Capillary Gel Cartridge 
 

The replaceable capillary gel cartridge contains a 147-mm capillary mounted into the cartridge body with a 
gel matrix top reservoir and built-in electrode pins. The capillary is automatically refilled with gel matrix 
between sample runs. 

 

 

 

 

 

 

  

 

 

Feature Description 
Capillary Glass capillary, Note: fragile glass tip extends beyond metal cartridge tip  

 
Anode pin A pin that connects to a positively charged electrode 

 
Cathode pin A pin that connects to a negatively charged electrode 

 
Label Cartridge label with lot number and expiration date 

 
Gel reservoir  Top reservoir containing separation gel 

 
Guiding groove Molded groove ensures correct cartridge positioning within the instrument 

 
Cartridge tip Metal tip of the cartridge 

 

 
 
 
 
 
 
 
 
 
 

Cartridge Tip 
 

 

Anode Pin 

Cathode Pin 

Capillary 

Gel Reservoir 
 

 

Label 

Guiding Grove 
 

 

Glass Capillary Tip 
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2.2.4 Sample Preparation and Analysis Kits 
 

Gly-X N-Glycan Rapid Release and Labeling Kits  
ProZyme Gly-X sample preparation kits utilize a novel in-solution enzymatic deglycosylation followed by 
labeling of released N-glycans with proprietary ProZyme Instant dyes. Gly-X with InstantPC is designed for 
UHPLC and LC-MS applications. Gly-X with InstantQ is specifically designed for CE separation on the Gly-Q 
System.  Labeling (1 minute) with InstantQ dye is followed by a simple 96-well vacuum plate-based clean up 
step.  The samples are then ready for analysis on the Gly-Q Instrument. With the deglycosylation and labeling 
all carried out in solution, the method is simple, rapid and suitable for automation.  

 

 

 

 

 

 

 

Feature Description 
Gly-X Deglycosylation 
Module for InstantQ 
Dye 

Reagents and consumables for rapid in-solution protein deglycosylation: 

• Gly-X Deglycosylation Plate 
• Gly-X N-Glycanase 
• Gly-X Digestion Buffer 
• Gly-X Denaturant 
• Gly-X Blocker (optional) 

Gly-X InstantQ 
Labeling Module  

Dye and solvents for instant labelling of released glycans: 

• InstantQ Dye 

• InstantQ Dye Solvent 

• InstantQ Activation Reagent 

Gly-X InstantQ 
Cleanup Module 

Clean up plate, eluent and plastic consumables for sample clean-up before analysis: 

• InstantQ Cleanup Plate A, 96 wells 
• Gly-X Collection Plate, 96 wells 
• Waste Tray for vacuum manifold 
• Gly-X Used-Well Sealing Caps, Black (for cleanup plate) 

Gly-Q Cartridge 
Module 

Gly-Q Cartridge, Separation Buffer, mineral oil and Reagent Tray: 

• Gly-Q Cartridge 
• Gly-Q Separation Buffer 
• Gly-Q Mineral Oil 
• Gly-Q Reagent Tray 

GlyQ Alignment 
Standards Module 

• Gly-Q Migration Standards 
• Gly-Q GU Ladder 

Note:  See the Gly-X Rapid N-Glycan Release and Labeling with InstantQ kit user manual for more detailed product and protocol 
information.  

Note: GX100 Gly-X Manifold Spacer is required for the Gly-X Rapid Release and Labeling with InstantQ Dye Kit.  

Labeling module 
 
Clean-up module 
 

 

Cartridge module  
 
 
Deglycosylation module 
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2.2.5.1 Gly-Q Alignment Standards  
 

Gly-Q glucose unit (GU) Ladder is generally the first run at the beginning of each sample sequence and 
produces >15 peaks in the electropherogram (see below).  The Migration Standards (MS) co-injected with 
subsequent unknown samples will be aligned to the Maltodextrin (GU) ladder for glycan naming and 
alignment purposes.   

 

 

 

 

 

 

 

 

Gly-Q Migration Standards (MS) are co-injected along with each unknown sample.  A lower migration 
standard (LMS) and upper migration standard (UMS) corresponding to 3 and 15 glucose units respectively is 
used to align with the above described Maltodextrin (GU) ladder.   

 

 

 

 

 

 

 

 
 
2.2.5.2 Glycan Standards  
Standards are highly purified and well characterized individual oligosaccharides or mixed libraries of 
oligosaccharides. They are used for Gly-Q method calibration and validation. For the list of available InstantQ 
Standards and Controls, please refer to the following website links:  

• InstantQ Labeled Oligosaccharides 
 
prozyme.com/collections/instantq-standards 
 

  

LMS 
 

UMS 
 

http://prozyme.com/collections/instantq-standards
http://prozyme.com/collections/instantq-standards
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2.2.6 Gly-Q Manager Software 
 
The Gly-Q Manager software controls Gly-Q instrument, collects and processes data, and reports results. The 
software features are organized into tabs and ribbon groups for easy intuitive navigation: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Feature Description 
Data tab Data tab enables: 

• Data review 
• Integration adjustment 
• Data reprocessing 
• Data export/reporting 
 

Processing Method 
Tab 

Processing method tab enables: 
• Processing method design 

 
 

File       
         Sequence       
                 Data 
                             Processing Method  
                                             Instrument Method   
 
 

 

Instrument Status Bar 
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Instrument 
Method tab 

Instrument method tab enables: 
• Instrument method design 
• Saving an Instrument Method 

File tab File tab enables and informs the user: 
• Serial Number of Instrument and Cartridge 
• Gly-Q Manager software version 
• Air Flow Check 
• Gel Flow Check  

Instrument Status 
Bar 

Instrument Status Bar informs the user: 
• Instrument connectivity 
• Progress of run 
• Estimated finish time of run 

 

Note:  See Section 4 for more detailed description of Gly-Q Manager functionality.  

 

SECTION 3: INSTALLATION 
3.1 Unpacking  
Inspect shipping boxes. If you notice apparent damage, contact ProZyme Technical Support, (800)457-9444 
(US & Canada); +1 510-683-6900; info@prozyme.com 

Unpack the system components and place them on the laboratory bench. 

 

Note:  The Gly-Q Instrument contains sensitive optics that can be influenced by condensation. If the 
instrument was shipped in cold weather, do not remove the instrument from the shipping box 
immediately, allow it to warm up to room temperature.   

 

3.2 System Location  
 

A suitable environment is important to ensure the best performance of the Gly-Q System. The recommended 
placement conditions are listed below:  

• Flat and stable laboratory bench with no devices generating vibrations 

• Clear space above the instrument to allow for capillary gel cartridge insertion 

• Clear space behind the instrument to allow for air circulation, electrical and air tubing connections 

• The ambient temperature should be stable and within a range of 20-30 °C 

• The optimal operating humidity should be within 40-95% RH range, non-condensing 

• The optimum altitude for Gly-Q System operation is 20-2000 m 
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3.3 Power Requirements  
The input voltage of Gly-Q Instrument is 24V DC, and the minimum current is 2A. A suitable power adapter 
with a cord has been included in the package (100~240V AC, 50-60Hz). 

The Gly-Q System air pump is available in 110V and 220V formats. 

 

3.4 Computer Requirements 
• Windows 7, 8.1 or 10; 64-bit version 

• 1 GHz or faster CPU 

• Minimum 8 GB RAM 

• 1 TB Hard Disk Drive; 500 GB Solid-State Drive preferred 

• Minimum 100 GB free space on the disk drive 

• Monitor and graphics card capable of Full HD (1920 x 1080) 

 

3.5 System Set-up 
 

 

 

 

 Plug air pump, Gly-Q Instrument power adapter, computer and monitor into approved and properly 
grounded power outlets. A surge protector is recommended to minimize power fluctuations.  

 Plug power adapter low voltage line into Gly-Q Instrument power inlet.  
 Connect computer and Gly-Q Instrument with USB cable. 

 Connect air pump outlet and Gly-Q Instrument air inlet port with provided 1/8-inch tubing. The airline 
from the air pump to the instrument is bisected by an air filter.  

 

Note:  After turning on the air pump it should run intermittently for less than 1 minute. If the air pump is 
running more consistently this is a sign of air pressure compromise that may affect performance. 

  

  

 

 

 

 
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The user should check the air filter and tubing for possible leaks. Spare tubing and replacement air 
filter are shipped with the instrument.  Contact ProZyme if you need assistance. 

 

3.6 Software Installation  
 

 

 Log into PC as Administrator.  

 Download the latest version of Gly-Q Manager from the ProZyme website:  
http://prozyme.com/products/gly-q-manager-software-gqsw2000 

Note: Please contact ProZyme for password information 

 

 Double click on the .exe file, click on Gly-Q Manager Setup.  
 Go through software installation steps.  

 

Note: If you have an older version of Gly-Q Manager software installed on your computer, you will be asked 
to uninstall it prior to installing a newer version. Installing new version of Gly-Q Manager won’t 
delete data. All user data will be preserved during installation.  

 

 

 

 

 

 

http://prozyme.com/products/gly-q-manager-software-gqsw2000
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3.7 Cartridge Preparation 
3.7.1 Components 
 

3.7.2 Unpacking and Preparing the Cartridge 
 

 Open gel-cartridge clam-shell container and remove the cartridge 

 

 

 Peel off the tape from side and top of cartridge (retain top tape for storage of cartridge between uses) 

.  

 

 

 

 

 

 

 

 

 

  
 Capillary gel cartridge clam-shell container (keep this for 
storage between uses) 

 

 Tape on cap (red, keep this for storage between uses) 

 

 Pin used to puncture the cartridge cap (white) prior to 
initial use 

 

 Gel reservoir.  Store the tip of the cartridge in the gel 
reservoir inside the clam-shell container 
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 Carefully remove and pin from package.  Insert pin into the hole of the cartridge cap and push it down 
to the end. Slight resistance should be encountered when performing this step. 

 

 

 

 

 

 

 

    

 

3.7.3 Priming the Cartridge 
 Turn off the Air Pump and use the illustration to reconnect the air tubing. 

 

 

 

 

 

 

 Put a buffer tray at the bottom of purge station  

 Slide the cartridge into the Cartridge Hanger and secure 
by turning the Locking Knob as illustrated.  

 Push the knob on top of the regulator down 

 Turn Air Pump ON 

 Pull Regulator Knob UP and turn CLOCKWISE to open 
airflow until pressure reaches ~ 0.5 mPa. 

 Droplets of gel should be observed flowing at cartridge 
tip in ~ 30-120 sec 

 Turn the Regulator Knob COUNTERCLOCKWISE until the 
airflow is OFF 

 Once the pressure returns to 0, push the Regulator 
Knob DOWN 

 Slowly release the cartridge and remove from priming 
station  

 

Regulator knob 
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3.7.4 Inserting the Cartridge into the Instrument 
 

 Gently wipe the cartridge tip with Kimwipe or similar tissue.  

Note: the glass capillary extends beyond the end of the metal tip, and is fragile, handle with care, do not 
tap tip on bench or hard surfaces.   

 

 After gently depressing cartridge door atop Gly-Q Instrument insert cartridge and close door. Push the 
cartridge to the Bottom 
 

 

 

 

 

 

 

Note: Cartridges can only be inserted in one orientation as shown in figure above.  

 

 Close Cartridge Door 

 

Note:  Dispose of spent cartridges by using a needle clipper, available with most sharps hazard systems to 
remove cartridge tip. The remaining cartridge is safely disposed of as trash.  The clamshell package 
can be added to most plastics recycling streams. 

 

3.8 Ending a Run 
 

1. After samples have been processed, the system will return the Cartridge to the Park position (see 
section 4.3, autosampler layout). 

2. Use the “Load Sample” and “Load Reagents” buttons to remove sample plate and reagent tray. 
3. Store the cartridge. 

a.  Remove the cartridge from the instrument and place tape over the cartridge cap (to 
cover the pin hole). Return it to the original clamshell packaging. The cartridge tip must 
be in contact with the gel block inside the package. Place inside the foil pouch and store 
vertically at room temperature. 

b. To store on the instrument:  Press the Park button before shutting down the system.  The 
cartridge can remain on the system for up to 3 days. Ensure that the Park position in the 
buffer tray (Section 4.4.3) is filled with water to prevent the capillary tip from drying. 

  
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3.9 Vacuum Manifold Setup 
ProZyme recommends the use of Millipore MultiScreen™ Vacuum Manifold (96-well) and Millipore High 
Output Pump (WP6211560 for 115 V/60 Hz or WP6222050 for 220 V/50 Hz)   

 

 

 

 

 

 

 

 
 Assemble vacuum manifold. 
 Connect vacuum manifold and pump inlet with tubing via liquid trap reservoir. 
 Plug pump into an approved and properly grounded power outlet. 
 

Note: For more detailed product information please refer to Millipore website:  

http://www.emdmillipore.com/US/en/product/MultiScreen%E2%84%A2-Vacuum-Manifold-96-well,MM_NF-MAVM0960R#overview 

https://www.emdmillipore.com/US/en/product/High-Output-Pump,-115-V60-Hz,MM_NF-WP6211560  

 

  

http://www.emdmillipore.com/US/en/product/MultiScreen%E2%84%A2-Vacuum-Manifold-96-well,MM_NF-MAVM0960R#overview
https://www.emdmillipore.com/US/en/product/High-Output-Pump,-115-V60-Hz,MM_NF-WP6211560
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SECTION 4: GLY-Q MANAGER SOFTWARE 
 

4.1 Starting Gly-Q Manager 
To start the Gly-Q Manager double-click the Gly-Q Manager icon on the desktop or select Start -> Gly-Q 
Manager.   

 

4.2 Controlling and Monitoring Gly-Q Instrument 
To control and monitor the Gly-Q Instrument with Gly-Q Manager, the instrument must be turned on and 
connected to a computer via USB cable.  

The samples are always analyzed as part of a sequence using a predefined set of instrument commands 
stored in an Instrument Method and a predefined set of processing commands stored in a Processing 
Method.  

When an analysis is running, you can monitor instrument operation via a status bar located at the bottom of 
the Gly-Q Manager screen and observe real time detector signal and sequence progress on the autosampler 
layout and sequence progress table.  

Direct instrument controls are accessible via the Sequence tab:  

 

 

 

 

 

  Park Cartridge moves cartridge into Park position for short term storage on the instrument (up to 3 
days). 

    

  Load Samples control rotates the autosampler for access to the sample loading stage.  

 Load Reagents control rotates the autosampler for access to load reagents including GU Ladder and 
Migration Standards.   

  

   
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4.3 Creating a Sequence 
A sequence defines how a group of samples is analyzed.  Sequence can be created on the Sequence tab by 
defining the following fields:  

Project & Run  

 

 

 

 Name your project by selecting “New Project” from the pull down, or select from the list of existing 
projects. 

 Name your run 

 

Methods 

 

 

 

 Select Instrument Method 

 Select Processing Method 

Note: Default Instrument Methods are recommended. See sections 4.6 and 4.7 on how to create 
Instrument Methods and Processing Methods.  

Sample Set 

 

  

 

 

 

 Define the position of the first sample 

 Define the direction the samples will be injected (↔ or ↕) 

 Define the number of samples to be analyzed 

 Define the number of injections (number of replicates for each sample) 

 

Note:  Changes are saved automatically and users are advised to double check these settings before 
starting a run.  If needed, type sample names and comments into the sequence preview table or 
import sample set list from Excel (see import CSV below) 

 

 
 

  
  

 
 
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4.3.1 Import & Export  

 

 Export feature allows for exporting a sequence in CSV (.xls) format 

 Import feature allows for importing a sequence in CSV (.xls) format 

 

4.3.2 Sequence Preview 
After a sequence is created, a table with a list of samples queued for analysis will be displayed on the main 
screen.  

 

4.3.3 Autosampler Layout 
 

The autosampler layout will show color coded positions for samples, reagents and standards.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

Reagent Tray for: 

(P) Park; 4 ml DI water + mineral oil 
to cover, optional 

(W) Wash/Waste; 4 ml DI water 
(C) Clean; 4 ml DI water 
(S) Separation Buffer; 4 ml, included 

with Gly-Q Cartridge Module 
 

P W 

S

 

C 
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Sequence Status Bar 
An instrument status bar at the bottom of the screen will display instrument status: 

 

 

 Sample name 

 Instrument method step 

 Well position 

 Sequence progress and estimated time of completion 

 Cartridge injection counter 

 System Pressure 

 Instrument status 

 

4.4 Running a Sequence 
4.4.1 Starting and Stopping a Sequence 
After a sequence is created it can be run by clicking on Start button: 

 

 

A sequence can be stopped by clicking on Stop button:  

 

 
 

 

 

 

 

 

 

 

 

       
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4.4.2 Monitoring Sequence Progress 
Sequence progress will be displayed on 4 elements of the screen: 

 

 

  Sequence progress bar at the bottom of the screen will show time remaining for sequence completion. 

  The electropherogram chart will show real time detector signal. 

  The autosampler layout will show completed samples (green), failed samples (red), currently running 
sample (blue) and queued samples (grey).    

  The sequence progress table will be updated with currently running sample highlighted in darker gray.  

 

 

 

 
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4.5 Data Review, Export and Reporting  
After data for all samples in a sequence have been acquired and processed, it is useful to review 
electropherograms and peak tables before reporting the results. Peak integration may need to be adjusted 
before results are reported.  This work is done on the Data tab shown below. 

 Select the Data tab: 

Data Tab 

 

The Data tab includes the following 4 areas: 

 Data View Ribbon – this includes tools to adjust and to export data 

 Data Files tree – the data you wish to work on is selected here 

 Electropherogram – this is the data display which can include 1 or more samples 

 Samples table – this is a list of the data that has been selected using the Data Files 
tree.  This table is used to select the samples that will be displayed on the 
Electropherogram and to review the peak table for the selected samples. 

 On the Data Files tree, select the sample set: 

Data Files 
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  On the Data View ribbon, select processed or raw data view and decide to show or hide annotations and 
instrument current signal: 

Data View 
 

 

 

 

Note:  Always start with processed data view with or without annotations. Raw data view and current 
are designed to aid in troubleshooting.  

  On the Sample table, select the sample(s) you want to view:  

Samples 

 

  Open the peak table for any or all of the samples selected by clicking on  sign before the sample 
name:  

Samples 

 

  Review peak detection and integration by highlighting peak line in the peak table and reviewing peak 
start and end markers on electropherogram view. If needed, zoom in with a left mouse click/hold; 
zoom out with a right mouse click and selecting un-zoom. 

Electropherogram 

 

Note:  In rare circumstances, the Lower Migration Standards (LMS) or Upper Migration Standards 
(UMS) may require manual adjustment. Please see the FAQs in Section 9 for further information. 
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  To make sure all peaks of interest are detected, adjust minimum peak area:  

Minimum Percent Area Adjustment 

 

Note: This slider is only active when a single sample is selected in the Samples table.  You cannot adjust 
the minimum percent area on more than one sample at a time, see   below. 

  Reprocessing data.  In some cases, one or more samples within a data set need to be reprocessed. To 
do this select the sample(s) to be reprocessed on the Samples table (NOT the Data Files tree).  Multiple 
samples can be selected in the Samples table and all selected samples will be displayed in an overlay 
electropherogram plot as shown below.  This facilitates sample comparison and allows reprocessing to 
be performed simultaneously on more than one sample.  Use “Shift+Click” and/or “Control+Click” to 
select multiple samples as shown below. 

Selecting Multiple Samples 

Example using “Control+Click” to select non-adjacent samples 

 

Note:  When more than one sample is displayed in an overlay electropherogram plot hovering the mouse 
over one of the plots will highlight the plot itself and the corresponding row in the Samples table.  
Conversely, hovering the mouse over a row in the Samples table will highlight sample in the table and 
the corresponding plot in the electropherogram. 
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In some cases, data from different data sets must be reprocessed in an identical manner.  Select data 
from multiple data sets in the Data Files tree and it will all be displayed in the Samples table.  To reprocess 
them all together you must combine them into a Virtual Data Set because reprocessing is restricted to 
data within a single data set.  To create a Virtual Data set first highlight the desired samples in the Sample 
table and then right click on any of the selected samples and select “Create Virtual Data Set” in the pop-
up menu. 

 

A dialog opens to name the Virtual Data set. 

 

Select the desired project, enter the desired names, and if desired select a calibration ladder.  Click on 
the “Create” button and the new Virtual Data Set will appear in the Data Files tree.  Click on this data set 
and only the samples included in the Virtual Data Set will be in the Samples table and only the first 
sample will be selected and displayed.  Before proceeding use “Shift+Click” or “Control+Click” to select 
the other samples in the Virtual Data Set. 
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To reprocess the data selected in the Samples table, select the desired Processing Method and click Process:  

Data Processing 

 
The new processing method will be displayed in the Processing Method column in the Samples table 
which is immediately to the right of the Sample Name.  

  After review, data can be exported in QDF, PDF, CDF or CSV formats:   

Export & Reporting 

 
• Selecting QDF export will create a file readable by Gly-Q Manager. This is particularly useful for 

sharing data with fellow researchers.  
 

• Selecting PDF export will create an electronic report that can be printed. The report will include 
electropherograms and peak data tables for selected samples. The header of the report can be 
customized in the File tab. 
 

• Selecting CDF export will create a set of files in the industry standard AIA format that can be 
viewed by other analytical data packages such as Chromeleon and Empower.  
 

• Selecting CSV export will create two files for selected samples: a file with peak table data and a 
file with XY data.  

4.6 Creating a Processing Method 
Processing method defines peak alignment, peak integration and peak calling. Gly-Q Manager installs 
equipped with several examples of processing methods. 

• Enbrel_Method: contains GU values for InstantQ-labeled N-glycans from Enbrel (Fc fusion protein) 
produced in CHO. Mainly biantennary glycans, some with α(2,3)-linked sialic acid, with some 
Man5. 
 

• Global_Method: GU values for a broad range of N-glycans, combining the data from all processing 
methods listed. 
 

• hIgG_Method: N-glycans from human IgG, biantennary, some with α(2,6)-linked sialic acid, some 
with bisecting GlcNAc. For glycoproteins produced in CHO use the Enbrel or Rituxan processing 
methods. Glycoproteins made in CHO generally lack bisecting GlcNAc N-glycans, sialic acid is 
α(2,3)-linked in CHO vs. α(2,6)-linked in human IgG, and human IgG does not contain a significant 
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amount of high mannose type glycans. 
 

• Rituxan_Method: N-glycans from Rituxan, monoclonal IgG made CHO. Biantennary, some high 
mannose. 
 

• RNAseB_Method: high mannose type N-glycans, Man5 through Man9. 

While these methods can be used as a starting point, each laboratory is expected to develop and validate a 
processing method that meets the needs of a specific application.  

 

 To create or modify a processing method, select the Processing Method tab and pick one of the existing 
processing methods from the drop-down menu: 

Processing Method Tab 

 

 

  In the Representative Sample tab, select a sample that most closely matches the samples you plan to 
process.  

 

 

  Open the peak table by clicking on  sign and review peak integration:  

Samples Table 

 

  Review peak detection and integration by highlighting peak line in the peak table and reviewing peak 
start and end markers on Electropherogram view. If needed, zoom in by clicking and dragging a rectangle 
around the area of interest; zoom out with a right mouse click and select un-zoom.  
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Electropherogram 
 

 

 

 In the Integration Parameters Tab there are four parameters available. 

• Select the Baseline Valley-to-Valley Modulation level.  A setting of 100% is recommended, 0% is a 
flat baseline, and 50% is half way between these settings. 

• Select whether Detect Shoulders should be used.  Checked will detect peak shoulders as separate 
peaks and is recommended, un-checked will identify peak with shoulders as a single peak. 

• Adjust the Minimum Percent Area using the slider or by entering a number directly until all peaks 
of interest on the representative sample electropherogram are displayed. 

• Select the Processed Data Range by entering a left window value and a right window value.  Settings 
of 4 and 14 are recommended. If the window is set outside of the LMS and UMS, these Migration 
Standards will be omitted from the percent area calculations. 
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 In the Component Table tab, check the Glycan Naming checkbox, define Peak Names, GU Units and 
Left and Right Windows.  The empty row at the bottom of the table can be used to add Glycans to 
the table. 

        

Note:  The Left Window and Right Window value controls will simultaneously change all values in the 
table that are currently set to the value displayed in the controls.  Values in the table that are not the 
same as the values in the controls will not be changed. 

  In the Alignment tab, define Lower and Upper Migration Standards, select Predictive UMS Search 
(checked is recommended), and check Dextran Ladder Rule:  

     

 

 Save the Processing method by clicking on Save or Save As. 

 

Note: After a processing method has been applied to a data set we recommend using ‘Save As’ if you wish 
to make changes to the method.” 
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4.7 Creating an Instrument Method 
Instrument method defines a set of instrument commands needed to execute the sequence. Gly-Q Manager 
ships with several examples of instrument methods that can be modified and saved by the user.   

  To create or modify an instrument method, select the Instrument Method tab and pick one of the 
existing instrument methods from the drop-down menu: 

Instrument Method Tab 

 
 

 

 Modify instrument commands for Calibration Ladder, Unknown Sample and End of Sequence steps by 
selecting Action, High Voltage, Duration and Autosampler Position:   

GU Ladder 

      

Samples 

 

Shutdown 
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The following instrument commands can be used to create an instrument method.  Click on the box in the 
Action column in any row three times to bring up the pop-up menu below to select a command: 

 

• High Voltage Purge: both high voltage and air pressure driven capillary purge 
• Purge: air pressure only driven capillary purge 
• Pause: pausing between steps 
• Reagent Block Injection: injection from dedicated reagent wells and troughs on the autosampler 
• Well Plate Injection: injection from a 96-well plate 
• Separation and Detection: running the sample and collecting data 

 

  Save the Instrument Method by clicking on Save or Save As. 

 

Note:  Instrument Methods that have already been used in a sequence cannot be overwritten and 
can only be saved under a different name (Save As option).  

 

4.8 Ending a Run 
4. After samples have been processed, the system will return the Cartridge to the Park position (see 

section 4.3, autosampler layout). 
5. Use the “Load Sample” and “Load Reagents” buttons to remove sample plate and reagent tray. 
6. Store the cartridge. 

a. Remove the cartridge form the instrument and place tape over the cartridge cap (to 
cover the pin hole). Return it to the original clamshell packaging. The cartridge tip must 
be in contact with the gel block inside the package. Place inside the foil pouch and store 
vertically at room temperature. 

b. To store on the instrument:  Press the Park button before shutting down the system.  The 
cartridge can remain on the system for up to 3 days. Fill the Park position of the buffer 
tray (Section 4.3.3) with water to prevent the cartridge tip from drying during storage on 
the instrument. 

7. Samples may be stored, covered with sealing film, at -20°C for at least on month or up to 5 days at 
4 °C. 
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4.9 File Settings 
File settings capture instrument serial number, cartridge and reagents lot information, define custom fields 
on data reports, perform air and gel flow checks.  

To update system settings, select the File tab: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Cartridge and reagents settings:  

 

 

 

 

 

 

 

 

 Instrument & software settings: 

 

 

 

 

 

 

 
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 Account settings: 

 

 

 

 

 

 

 

 

 Data storage settings: 

 

 

 

 Airflow check: 

 

 

 

 

 

 

 

 

 Gel Flow check: 
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SECTION 5: CARE AND MAINTENANCE  
 

Time Interval  Procedure 
Weekly Release condensation in the air pump 

• To release condensation, press the button in the bottom of the 
water cup 2-3 times to release the water in the cup. 

Monthly Air filter check 
• Turn off the air pump and release condensation in the water 

cup. 
• Check the air filter. If the filter is damaged or wet, use a new 

filter to replace the old one. Replacement air filters are 
available from ProZyme.  

• Turn the air pump on. 
• Air flow can be assessed using the Air Flow Check functionality 

described in section 4.8, above. 
 

SECTION 6: SYSTEM SPECIFICATIONS 
General Technical Specifications 

Environmental conditions 
Operating temperature 
Operating humidity 
Operating altitude 

 
20-30°C 
40-95% RH, non-condensing 
20-2000 m 

UL installation category Category II 
 

 

Instrument Specifications 
Input voltage 100-240V, ~1A, 40-60Hz 

 
Output voltage 1-15 kV  

 
Light source LED (310 nm) 

 
Fluorescence detector Photomultiplier tube, A/D resolution 18 bit, long 

pass filter >385 nm  
 

Computer connection USB  
 

Physical dimensions (W x D x H) 30 x 38 x 40 cm  
 

Weight 15 kg  
 

 

Gel Recharging Air Pump Specifications 
Input voltages 100-110V 

220-240V 
Output pressure range 1-100 psi 
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SECTION 7: WARRANTY STATEMENT 
 

Limitation of Liability 

Gly-Q Analyzer, software, and all related reagents are designed for the use of electrophoresis analysis in 
general bio-chemistry laboratory for Research Use Only.  

BEFORE ATTEMPTING TO OPERATE THE INSTRUMENT, READ ALL PRODUCT MANUALS AND FOLLOW THE 
INSTRUCTIONS. 

ProZyme assumes no liability whatsoever for any personal injury, property damage, or other loss resulting 
from not complying or familiar with the manuals, or improper operation of the devices. 

 

Warranty statement:  

ProZyme warrants all purchased products (other than extended warranties) against damage, defects in 
materials or workmanship, and failure to conform to the Quality Specifications, for the period commencing 
upon receipt of each purchased product by ProZyme Inc. through one (1) year after delivery of such 
purchased product to ProZyme’s customers. 

If, during the warranty period, any purchased product is discovered to be defective by reason of materials, 
workmanship or failure to meet the Quality Specifications, please contact ProZyme Technical Support, 
(800)457-9444 (US & Canada); +1 510-683-6900; info@prozyme.com 

 

Terms and conditions of sale may be found at: http://www.prozyme.com/terms.html 

 

  

http://www.prozyme.com/terms.html
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SECTION 8: INSTRUCTIONS FOR DEPOT REPAIR RETURNS 
To return the instrument for repairs, follow the steps below to clean surface and detached connectors and 
tubing. 

 Open the cartridge door and ensure there is no cartridge in the instrument. 

 Check the sample and buffer tray to ensure there is no sample or fluid left in the instrument.  

 Use 70% Ethanol (v/v) to clean the surface of the instrument for decontamination. 

 Unplug the USB cable in the back. 

 

 Unplug the power cable in the back. 

 

 

 

 

 

 

Secure the cable node  

Pull the connector header to unlock and detach the cable from instrument  

  

    Remove the air tubing by simultaneously pressing the connector and remove the tubing rapidly 

 

 

 Compete the ProZyme Decontamination Form (contact info@prozyme.com), pack the form with the 
instrument and contact the local distributor for shipping details 
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SECTION 9: FAQS 
Q. Why does Gly-Q Manager not allow me to edit the Sequence Table I am preparing? 

A. Be sure you have entered a Run Name before editing the Sequence Table 

 

Q. Does the Gly-Q instrument require a minimum volume for analysis? 

A. The Gly-Q instrument requires a volume of at least 30 µL in a 96 well plate well for a run.  

 

Q. Gly-Q Manager does not seem to be communicating to the instrument. How can this be fixed? 

A. Ensure that the USB cable is intact and installed correctly. 

Ensure that the instrument is turned on.  

If 1&2 above are confirmed, reboot the instrument and computer. Occasionally communication can be 
lost if a prolonged period of inactivity is incurred.  

Gly-Q Manager installs a Device Driver. If the driver is not installed properly instrument communication 
will not occur. Check with your IT professional to insure your computer is configured to accept Device 
Driver installation.  

 

Q. How do I remedy the following error messages? 

 

A. Ensure that the cartridge is installed correctly as per section 3.6.2, above. 

 

 

A. Ensure that airline connections are intact and air filter is current and functional. The Airline Check in section 
4.8 is another way to check this parameter. 
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Q. The Air Pump runs quite frequently. Is this normal? 

A. The air pump should run for ~ 30 seconds sporadically throughout an analysis session. If the pump is 
running for greater than 1 minute regularly throughout the run this could be an indication of air flow 
compromise. Again, the user should check integrity of airlines, air filters and perform the Air Flow function 
described in Section 4.8, above. 

 

Q. When is the Gel Flow Check function used? 

A. The Gel Flow check in section 4.8 is used to insure gel flow in a cartridge is optimal. If a cartridge is stored 
improperly the capillary may become clogged and consequently functionality may also be affected. The Gel 
Flow Check can be used to determine presence of a potential clog. If a clog is detected the user is advised to 
prime the cartridge as described in the cartridge preparation section, 3.6.2.  

 

Q. The Lower Migration Standard (LMS) and/or Upper Migration Standard (UMS) were not found or aligned 
correctly. What can I do? 

A. Within the Data Tab, Sample window, expand the sample to list all peaks as shown in the illustration below. 
Right click on the sequence that corresponds to the LMS/UMS and designate it as such. GlyQ Manager further 
helps facilitate this process by enabling visualization with the corresponding electropherogram in the window 
above the Sample. Please see below for an example.  

 

Manually designated LMS or UMS will be named accordingly in bold print, see below: 
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Q. When collecting data, why can it not be saved in real time on a network or to a cloud location? 

A.  The system collects data in real time and is designed to save data on the local hard drive to prevent data 
loss if the network or internet connections are down.  Once data has been collected there are a number or 
options available to move data to other computers.  You can move data to a different computer running 
Gly-Q Manager using the data export and data import functions using the QDF data file format.  If you want 
to analyze data using programs that support the industry standard AIA format such as Chromeleon or 
Empower you can use the data export function with the CDF data file format.  If you want to analyze data 
using programs that support the CVS format such as Microsoft Excel you can use the data export function 
with the CVS data file format. 

 

 

 

SECTION 10: LEGAL NOTICES 
 

10.1 Trademarks & Tradenames 
 
ProZyme, Gly-Q, Gly-X, N-Glycanase, and InstantQ are trademarks or registered trademarks of ProZyme, 
Inc., in the United States and other countries. All other trademarks are the property of their respective 
owners. 

Failure of a mark to appear on this page does not mean that ProZyme does not use the mark nor does it 
mean that the product is not actively marketed nor is not significant within its relevant market. 

 

10.2 ProZyme Virtual Patent Marking 
 
Visit http://www.prozyme.com/patents for a list of ProZyme products and patents. 

 

 

SECTION 11: RESOURCES AND REFERENCES 
Visit ProZyme’s website for additional information, downloadable posters, publications and technotes. 

http://prozyme.com/pages/resources 

 

  

http://prozyme.com/pages/resources
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SECTION 12: TECHNICAL ASSISTANCE 
ProZyme is committed to developing rapid, automatable methods for glycan analysis. Call us to discuss 
products in development. 

If you have any questions or experience difficulties regarding any aspect of our products, please contact us: 

TOLL FREE (800) 457-9444 (US & CANADA) 

PHONE (510) 638-6900 

FAX (510) 638-6919 

E-MAIL info@prozyme.com 

WEB www.prozyme.com 

ProZyme values customer opinions and considers customers an important source for information regarding 
advanced or specialized uses of our products. We encourage you to contact us. We welcome your 
suggestions about product performance or new applications and techniques. 
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